Importing Word Referral Forms for use in EMIS Web with
Integrated Word

Saving the referral forms

To use the forms with your clinical system, you need to download them from the Knowledge Anglia
site. nww.knowledgeanglia.nhs.uk

NOTE: If you use the www link to the Knowledge Anglia site, you will be asked to log in. Change the
first ‘w’ to ‘n” and you will be on the N3 user site which does not require a log in.

Select your CCG using the relevant icon.

N3 User

Great Yarmouth and West Norfolk
Waveney

After selecting your CCG hover over the ‘Forms’ section, this brings up a “Pop up” window as shown
below.

South Norfalk N3 User

Providers [ Services

Clinical Information Prescribing, Pharmacy and

Medicines Optimisation

Clinical Thresholds Policy

Cancer / 2WW

MNorfolk & Norwich Hospital (NNUH)
James Paget Hospital (PUH)

Queen Elizabeth Hospital (QEH)
West suffolk Hospital (WSH)

Multi-organisation forms
Any Qualified Provider

Endoscopy

Fertility

Mental Health & Learning
Difficulties

Learning Difficulty (LD)

Meantal Health

Community Services
All Community Services
Children

End of Life

Exercise

Infectious Diseases

Integrated Care (ICN/ICO)
Smoking

Terminatien of Pregnancy (ToP)

Continuing Healthcare
(cHC)

Hospitals
Global Diagnostics
Ipswich Hospital
James Paget Hospital

» Norfolk & Norwich Hospital
Queen Elizabeth Hospital
West Suffolk Hospital

Incident reporting /
Quality issue concerns

Individual Funding
Requests

Medicines / Prescribing
Non-NHS

Practice Admin

Services to Primary Care

Select the relevant area e.g. Norfolk & Norwich Hospital.
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GP Clinical Threshold
Referral

GP Clinical Threshold Referral - RMS
Participation

Safeguarding

Safeguarding Adults
Safeguarding Children (LSCB1)

Guidance

Referral Form Creation Guidance
Systmone User Guide

Emis User Guide

After selecting you are presented with the various forms that are available for this location.
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http://nww.knowledgeanglia.nhs.uk/

= Elsie Bertram Diabetes Centre (NNUH)

Referral (Word)

U: 08/02/19 R:08/02/21

Referral (SystmOne)

Referral (EMIS Web)

NOTE: There may alternatively be an option to choose an EMIS LV version. This can be treated

exactly the same way as the one for EMIS Web.

Right click on the EMIS Web version, and select to save the file to a temporary location on your
practice computer or a shared drive you use.

Q' Home

&

elsie_bertram_dia....ewdt

c

X Q' NNUH Forms X + = (a]
@ https;//nww.knowledgeanglia.nhs.uk/KIM or tals/NorfolkNorwichHospital.aspx * 6
Arthritis - Suspected Early Inflammatory Referral U:01/08/16 R:09/05/19 B Hearing Aid Assessment (NNUH) U:22/11/18 R:22/11/20
(NNUH) Referral (Word)  Referral (SystmOne)  Referral (EMIS
Referral (Word) Referral (EMISLV) Refer ystmOne) =
® BD Clinic - Referral (NNUH) U: 01/04/14 R:01/04/17
B Audiology - Benign Paroxysmal Position Vertigo (BPPV) U: 01/08/18 R:01/08/20 Referral (V Referral (EMISLV)  Referral (SystmOne)
direct referral (NNUH)
Referral (Word)  Referral (SystmOne)  Referral (EMIS Web) B Iron Deficiency Anaemia (NNUH) U:02/07/14 R:23/10/19
® Aural Care Clinic (NNUH) U: 01/02/17 R:01/0; f (AIH ETal(Eh
Re V) Ref m B Leg Ulcers - Vascular Referral (NNUH) U:01/04/16 R: 18/09/19
B Bone Densitometry Request (NNUH) U:01/11/16 R: e ee) TR, L gl
Referral Word)  Referral ( V) Referral (SystmoOne) B Maternity Booking Form (NNUH) U:01/05/13 R:14/12/17
eferral (Word)  Referral (EMISLY) Referral (SystmOne)
B Breast - Familial History of Cancer (NNUH) U:01/11/10 R:01/1117 Befesial ! aliEMIE fieferal BysanOn
Referral (Wo rral (EMIS LV Referral (SystmOne) B Neurological Nurse Specialist referral Form (NNUH) U:17/06/11 R:05/10/18
Referral (W ral (EMIS LV Referral (SystmOne) i g P!
B Breast - Symptomatic and Reconstruction (NNUH) U: 0111710 R:01/1117 ReferraliWore)Retercal (EMI>-EV) i Refe ral (5ystniOnG)
Referral (Word) Referral ( V Referral (SystmOne) 2 Obstructive Sleep Apnoea Checklist (NNUH) U: 24/02/06 R: 24/07/17
B Diabetes Nurse Facilitator (NNUH) U: 16/01/17 R:16/01/18 Refereal (Word
Word) V)  Referr One) B Older People's Assessment Service (OPAS) (NNUH) U: 16/01/18 R: 16/01/19
U: 04/08/15 R: 04/08/16 Referral (Word)  Referral (E V) Referral (SystmOne
R Referral (SystmOne) B Oxygen Assessment Service (NNUH) U:01/11/14 R:19/11/19
B Dietetics (NNUH) U:07/12/18 R:10/07/21 Referval (Word),iReterral (EMISI) CiRetenal (SysmOne
Referr (Systm ) Referral (EMIS Web) B Paediatric Hearing Assessment (NNUH) U:01/08/18 R:01/08/20
Referral (Word) eferral (SystmOne) Referral (EMIS t
Dyslipidaemias Referral (NNUH) U: 03/06/18 R:03/06/19 DS LI 4 mor ral (EM
Referral (Word)  Referral (EMIS LV Referral (SystmOne) B Rapid Access Chest Pain Clinic (NNUH) U: 01/07/17 R:05/09/19
) Referral (EMISLV) Referra stmOne
B Echocardiography - Open Access (NNUH) U:01/03/17 R: N AR (D A ‘ o
Referral (Word) Referral (EMISLV) Referral (SystmOne) B Restrictive Lingual Frenulum Referral (NNUH) U:01/08/16 R:01/08/18
Referral (Word)  Referral (EMISLV)  Referral (SystmOne
Elsie Bertram Diabetes Centre (NNUH) U:08/02/19 R:08/02/21 Refsreal (Wora LaL{EM YIRS al Oy imOn
Referral (Word) eferral (SystmOne)  Referra ) ® TIAClinic / Stroke Prevention Clinic (NNUH) U: 01/08/18 R:01/08/20
Referra Referral ( r EM
B Endoscopy Open Access Upper Gl - Dyspepsia (NNUH)  U:21/12/1¢  Open link in new tab retens = - EA
- Under review . ) Open link in new window I Access) Referral U:09/03/18 R:
Referr Referral (SystmOne)  Refet Referral d) LV) Referral (SystmOne)
- Open link in incognito window
B Female Sterilisation (Laparoscopic) U: 28/09/1¢ {Form (NNUH) U:22/08/14 R:
\ Referl  save link as... [ R ral ral (EMISLV)  Referral (SystmOne}
U: 01/03/17
Y
Referra Refer
Inspect Ctrl+Shift+1
~ A Show all

Open link in new tab
Open link in new window

COpen link in incognito window

Save link as...

Copy link address

Internet Explorer:

H/10/16 R:01/10/18

Referral (Systrp=-==

Open

Open in new tab

Open in new window

Save target as...
Print target
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Import the forms into EMIS

Go to Template Manager

Select Document Template tab in the header in the left hand tree
Select folder in left hand tree that you want to import the template into
NOTE: You cannot import into the root folder of the hierarchy

AN LSS MOHRBE DO HE
ems

Organisation Configuration  Data Sharing Manager  Confidentiality Policy Manager

OHFH A i P =

. 4 Copy
Add Froperties

Formulary Manager | Te: Concepts Manager

ate | D import E‘ ‘% @

Hide  Show  Trigger  TestRequest
Archived Archived Viewer Template

View Trigger Config
#  Yoursecurity details have not been logged. Click hre to resolve.

x
Templates & Protocok pacyment Temp 4| * Name Description Date Modified Status
Norfolk Waveney Search_Reporting

4 2 Norfolk& Waveney Search &Reporting
EMIS Library

EMIS Test
Fitness To Work
| Knowledge
Test
TestFolder

Please selectan tem

Practice Manager (SIR004) | SWALLOW, Michael (Mr) | _Location: Norfolk & Waveney Search & Reporting

Select Import from the ribbon, this will open a dialog in which you can navigate to where the template
was downloaded and saved.

NOTE: If the template was an LV template as opposed to a WEB one you will need to change the file
type selection in the dialog to ‘all template files’.

Clicking the ‘open’ option at the bottom of the dialog will import the template.
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@v’.‘IS/EBU\’%EEiU'EH 5 : b Haalth Care Syt SR
S Organisation Configuraion  Data Sharing Manager  Confidentiality Policy Manager  Formulary Manager | Template Manager | Concepts Manager = N )
1 ﬁ &cu p > o activate  [R)import ~ ‘j
i (= i &
™ Copy ¥ ) Deactivate | Expor
{ Propeties o Pt O o Hide  Show  TestRequest  EMIS
. APaste | 3 Archive Archived Archived  Template Header/Footer
Add 1 Edit Template View Config
i Yoursecurity details have not been logged. Click here to resolve. x |
Document Tempates (praryftems | 41>/ Name Descrption Type Date Modfied Status -
S —— # adutt_phlebotomy_hard_to_bleed_jpuh_emisi/ Imported tem. Document Tempiate 10-Sep-2018 Active
= 5 # afwn_referral_qeh_emisl X Templ -Sep- A
4 2 Norfolk& Waveney Search &Reporting afwn_referral_qeh_emis! Imported ttem. Document Template 10-5ep-2018 ctive
1 1 EMIS Library | ® bppv_audiology_drect_referral_nnuh_emis Imported ftem. Document Template 05-5ep-2018 Active
{5 EMIStemplal &ms Open X [Aug-2018 Active
15 Fitness towol — [Sep-2018 Active
(. Knowledge | < v 4 B> ThisPC » Desktop v & | SearchDesktop o kep-2018 Active
Organize v New folder v [N @ fuo2018 Active
~ 5ep-2018 Actve
v o Quick access Name Date medified Type Size 7N
5] Docman 10 Updater 1 Internet Shortcut 1K8 jan-2019 Active
M Desitop  # + | Docman Migration Shortcut 2k8 [5ep-2018 Active
¥ Downloads # 31| FAQ - Shortcut Shoitcit 2K8 Sep-2018 Active v
= * [ % ices - Shortcut Shortcut 3KB |
& Pictures # »1| Highlight Reports Shorteut 2kB F
Admin #E Information governance for SCR - NHS Digital Internet Shortcut 1KB
b 171 KMS Spreadsheet Plan.dsx - Shortcut Shortcut 2KB
" 127 LDR Report Primary Care.xis - Shortcut wt 4KB
ine
77 MSwallow practice monthly reports S1 and EML... Shortcut 3KB
ol o 2] My ESR Internet Shortcut 1KB
v 8 This PC ) New Intemet Shortcut 1KB
> B Desktop %) NNUH Microbiology & Bloodtrans 03,03,17.dsx ... Shortcut 7KB
= ) Practice Details (for projects use) V1.1xlsx - Sho... Shortcut 2KB
|5 Documents
1] Programme Plan Condensed 30.01xlsx Shorteut 2k8
¥ Downlosds [ radiclogy_qe_emisweb.ewdt EWDT File 12K8
o) HUAWEIP20Pro g gh yon Type: EWDT File Shortcut 2k8 o)
R — R T :
File name: | | Date modified: 07/02/2019 14:52 | |EMIS Web Document Template
—
Practice Manager (SIR004) |  SWALLOW, Michael (Mr) | Location: Norfolk & Waveney Search & Reporting

Once the template has been imported you can view and amend it by right clicking on it and selecting
‘document template edit’.

NOTE: If the imported template is an LV template rather than a Web one, some fields such as patient
mobile number will need replacing with the correct merge field as some of these have changed
between versions.

AR/ E /AT ES E

- e r
| ﬁ&m pg;

Q@ p - EMIS Web Health Care System - Norfolk && Waveney Search && Reporting - 30202 - B8 X

yManager  Formulary Manager | Template Manager | Concepts Manager Re®

%méé 3

at

™~
Ad  Edt P Dy, | o Ve, P 3 Denclivele R Exort TestRequest  EMIS
. w [ 13 Archive Archived Archived = Template  Header/Footer
Add | Edt Templste View Config
i P Your security details have not been logged. Click here to resolve. x \
Document Templates | iprary Rtems “» Name Description Type Date Modified Status A
Norfolk W Search R = ® breast_famiy_history_nnuh_emsiv Imported tem. Document Template 05-Sep-2018 Active
1@ T 4-Sep-
4 & Norfolk& Waveney Search & Reporting ‘community_nursing_therapy_nchc_emislv Imported tem. Document Template 24-Sep-2018 Actve
[ EMIS Uibrary ®  copa_tookt_gyw_hubs Imported kem. Document Template 12-Aug-2018 Active
[ EMIStemplates - 50004 # elsie_bertram_diabetes_cntr_nnuh_emislv Imported tem. Document Temphte 17-Sep-2018 Active
I3 Fitness towork # endoscopy_anticoag_management_doacs_qe_e...  Imported kem. Document Template 18-)20-2019 Active
[ Knowledge | |® endoscopy_anticoag_management_warfarn_ge_... Imported tem. Document Template 05-5ep-2018 Actve
& fees_payable_medical_practitioners_gyw_emislv Imported kem. Document Temphte 04-Sep-2018 Active
3)
];) radiology_qe_ e 5 o Document Template 07-Feb-2019 Actve
s e 8l_nd Document Template 2 Inactive
4 Status. » Print Doc Template
® tnpwt_referral_ncf| o Document Template Active
® work_for_county_( % Ut Document Tempiate 17-5ep-2018 Active e
" Copy Export
| radiology_qe_emisw 1 p,...
General History %) Refresh
é 4  Properties
Type: Document Template
Description: Imported tem.
Verson: N/A
Modffied: 07-Feb-2019
Author: mswalow

Organisation: Norfok & Waveney Search & Reporting
Status: Active

Practice Manager (SJR004) | SWALLOW, Michaei (Mr) | Location: Norfolk & Waveney Search & Reporting
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Using Referral Forms in EMIS

Open the appropriate consultation
Select Referral from the left hand menu
Add > Document > Create Letter

= LS 5 o ENoN i a0 = EMIS Web Health Care System - Norfolk && Waveney Search && Reporting - 30202 - a8 X%
= g # Lo 1 P
lemi

# Summary | Consuitations | Medication Froblems Investigations CareHistory Diary Documents Referrals =R ]

8 =YL EH%e

B Search CR
. Trend Filters. View Print Config Search

My
Consultations

fiew Filter Print | Config | Knowled

Born  01-Jan-1980 (39y) Gender Male NHS No.

Date Consuftztion Text

Minor Surgery
Quick Note

Code

Alergy

Referral 3
Letter

Document

Problems *

J
Practice Manager (SIR004) | SWALLOW, Michael (Mr) | Location: Norfolk & Waveney Search & Reporting

Select New Document/Find appropriate template

Commonly used templates will appear in the New Document dialog.

If the template you require is not in the dialog, clicking on the magnifying glass in the bottom right
hand corner will open the ‘Find Document Templates’ dialog box.

Double click on the template you wish to use.
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‘»s\)”‘/’&/é‘!%dﬁémf""—liﬂ 7 =%
ems
Summary | Consultaticns | Medication Problems Investigations ~CareHistory Diary Documents Referrals He®
@ Edit Consultatio 8 % View Deleted v p @ @ @
¥ 4 Col n My =l
| Add Trend 2 Filters =
|| . [*1Sharing . Consultations " VigFind Document Templates X
| Add/Edit Vi Siiter | Find document template or use the hierarchy to browse
— = | - v
P

v M
¥ MICKEY, Mouse (Mr) Herarchy  preview

Date Navigator Date Consult] 4 .3 Norfolk& Waveney Search &Reporting
4 [ Knowledge
&) adult_phlebotomy_hard_to_bleed_jpuh_emisiv
) afwn_referal_geh_emislv
Please select ether a blank document or 3 template from % bppv_audiology_direct_referral_nnuh_emish
the list below, or find the template you wish to use. ® brain_cns_cancer_qeh

%) breast_family_history_nnuh_emish
%) community_nursing_therapy_nchc_emisiv
2 copa_toolkit_gyw_hubs
%) endoscopy_anticoag_management_doacs_ge_emisiv
) endoscopy_anticoag_management_warfain_ge_emislv
%) fees_payable_medical_practitoners_gyw_emis
® radiology_ge_emisweb
) tnpwt_referral_nchc_emishv
& work_for_county_councils_gyw_emisiv

oK Cancel

No data

0K Cancel

Problems EY

Practice Manager (SJIR004) | SWALLOW, Michael(Mr) | Location: Norfolk & Waveney Search & Reporting

The template will pre-populate with the merge fields from the patient record.
Add any other appropriate information.

‘-:m\ﬂ’“fn"r/ HREREDE 2@ HE - MCKEY, Mouse M) = o

Summary  Consuhtations Medication Problems Investigations  CareHistory Diary Documents Referrals | Patient Document

Adive ¥ MICKEY, Mouse (Mr)

Mail Merge Fields < FILE TOOLS VIEW New Patient Letter 1 [Compatibil... = -

- 7|

File Properties

Tel OIS0 Fex 015810 T+ o patent [ Brasstiosdng B gt

. [ Pamay sigmea [ #ard of hesrng
Patient Details Radiology Referral - Fax: 01553 613838 P [l | =

FullName - PATIENT DETAILS i
FullName(ine, middk) T v Dos IR The patent nesds = [ mizpreter || (speary sngusge) [ Lpspesker [ 550
Title Sumame | Miskey Haspral No: -

= " For examinations that requira ITaVENOLS COMras! MAd, yoU MUSt Stat rcent
Calling Name e il EGFR rasut: Dateof
Given Name pdress uale st
Middle Name | P DT

Sumarme Authorised by: Qu Os Or
Previous Ssumame
Title Initial Last Name

REFERRAL DETAILS

Open Access Chest X-Rays - Take this form to the Radiology

Registere Refri
Tile Last Name == e Department at the Queen Elizabeth Hospital, Monday to Friday
age o Camgoy. |0V Dcaz 0O (except Bank Holidays) 9.00 am - 4.00 pm. No appointment
Date of Birth tome - needed:

Practice Is tanspot | Yes / No O
Gender Adaress regared?
Gender{full Wyes ist: | Ambuiance [ Car

Date of Registration Refonal date: Refares
Patient Type Prit name: agnature
NHS Number
Hospital Number Incomplete Patient, Clinical or Referrer details may result in this form being
returned to you
EMIS Number (IR
PASNUmber Priority will be decided an clinical informatian given
! Contact its CLINICAL INFORMATION
b Usual GP Clscal Protiem
I Registered GP
I Home GP Examinston rquested B rrory O Rowne

@D hickans cumman

K —

£, Patient Details

ADDITIONAL INFORMATION

[\ Clinical Content

<% Organisation Details

@ Miscellaneous Items SCREENS 1-2 OF 2 -+ 100%

Practice Manager (R004) | SWALLOW, Michzel (Mr] | Location: Norfolk & Waveney Search & Reporting

Once you are happy with the document, click File > Save and Close.
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The template will then be saved as a document in the Patient record.

Qo/E/7BTIRE E

Summary  Consultations  Medicsion  Problems  Investigalios  CarsHistory Diary Documents Referrals  Patient Document ¢ @

=l = EMIS Web Health Care System - Norfolk 8& Waveney Search && Reporting - 30202 — o x
MICKEY. Mouse (W) y Y porting

Active ¥ MICKEY, Mouse (Mr)

Mail Merge Fields « FILE

= A
.4 E
File Properties
e OISEIGTIN Fax o 6 1s be patent: [ Breastiesding O Pregrant
: Partialy sighted Hard of hearny
Prink Radiology Referral - Fax: 01553 613838 Ot O e e
Sove and Close o= the patent requirhalp [ Changing [ Transtermng
B PATIENT DETAILS
Sawe e Tie e Son i-dan 1950 e patient neads an L] miarpeeter [ (specdy languege) [ Upspeaker [ BSL
nterpreter
Sava Ao . L ot For examinations that requirs inlravenous contrast media, you must state recent
Forname | Mosse WHS No: -
Close u EGFR resun Dste of
GrerETE haaress: Gender | Male resuit
Tel N
Middle Name = e = t Use Oty
Sumame Authorised by: Qu Os Or
Previous Surname TEE L ) )
Title Initial Last Name e o Open Access Chest X-Rays  Take this form to the Radiology
Jitle LagtName = pe Department at the Queen Elizabeth Hospital, Monday to Friday
Age p,&m: Categoy. |0 N.{; Dcaz @ (e:eodeg; Bank Holidays) 9.00 am — 4.00 pm. No appointment
Date of Birth - needed.
Practice. s transport | [ Yes / Ne @
Gender Address: requred?
Gender(full) Hyes isit | [ Ambuiance [ Car -
Date of Registration Referal date: Referers
Patient Type Font name. signature
NHS Number
Hospital Number Incomplete Patient, Clinical ar Referrer details may resultin this form being
returned to yoi
EMIS Number 1IR| ]
Pas Number Priority will be decided on clinical information given
! Contact Details CLINICAL INFORMATION
b Usual GP Cinisal Protiem
I Registered GP
I Home GP Examination requested: 0 Presity B Rousne
G hictar cimmans b
4] ] | »

P o ‘ADDITIONAL INFORMATION
£ patientDetails

[ Clinical Content

/52 Organisation Details

Lz SCREENS 120F2 &

Practice Manager (SIR004) | SWALLOW, Michael (Mr) Location: Norfolk & Waveney Search & Reporting
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Completing Forms
When completing the form, please note the following:

To follow the Hyperlinks
All forms with supporting text in the system have a blue hyperlink at the top of the form. These links
only work if the document is unprotected. see adding additional text below.

To annotating Images
The Word drawing function can be used to annotate anatomical diagrams if they need to be marked
as part of the form completion, the Word drawing function can be used.

NB This can only be done whilst the document is unprotected.

NB To See Drawing options select ‘Shapes’ from the Insert menu:

Home Insert Page Layout References Mailings Review View Ac
=

= = =53 | i )

5 ] 5 a| g o2 - 2

Cover Blank Page Table Picture Clip |Shapes |Smartart Chart Hyperlink
Page = Page Break @ Art -

Pages Tables Recently Used Shapes

E~xNOo0oo0ALLe o

= AN S+
- Lines
@ NNNTLL T ARG
z Basic Shapes
@ BEraT 006 ANO O

To select options and add additional text
to enter additional text, and select check boxes etc. Click on ‘Restrict Editing’ on the Review menu:

Mailings Review View Acrobat
= - =D 2% Final: Show Markup - oo #} Previous 2 N_,.‘
il . tawm B g & I = [Ny
= 3 show Markup ~ = = 2} Next -
New Track L Accept Reject Compare Restrict| Linked
Zomment Changes = [B] Reviewing Pane - - - Editing | MNotes

Comments Tracking Changes Compare Protect OneNote

To protect the form, select the following:

Restrict Formatting and Editng ¥ % vy can then type in the greyed out areas only, or click into the

1. Formatting restrictions Check boxes to select.
Limit formatting to a selection of
styles NB - do not un-protect the form after you have entered information
Settings... into the greyed out boxes, as when re-protecting the form, you will
2. Editing restrictions lose your changes.
Allow only this type of editing in the
document:

Filling in forms B

Tracked changes
Comments

Filling in forms

(You can turn them o

Yes, Start Enforcing Protection
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